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1. Introduction 

 

BackupAssist provides comprehensive Exchange Protection by 

creating backups that can be used to restore an Exchange 

Server, an Exchange information store database, Exchange 

storage groups, mailboxes and individual mail items like 

emails, contacts and appointments.  

BackupAssist Exchange Protection uses the three standard backup types: File Protection, File Archiving 

and System Protection.  

These backups can be used to: 

 Restore your Exchange Server and databases using the Integrated Restore Console. 

 Restore individual mail items using the Exchange Granular Restore console. 

Using this document 

This Exchange Protection user guides explain how to back up your Exchange Server, and how to restore 

an Exchange Server or individual mail items. 

 If you want to perform an Exchange Server restore, see the Exchange Server restore section 

This restore uses the Integrated Restore Console, which is a standard BackupAssist feature. 

 If you want to restore mail items, see the Exchange Granular restore section. 

This restore uses Exchange Granular Restore, and requires an Exchange Granular Add-on license. 

Documentation 

This guide provides a comprehensive guide to Exchange Protection and can be used in conjunction 

with other BackupAssist guides. 

 To protect individual Exchange mailboxes, see the Exchange Granular Restore Quick Start guide. 

 For information on the BackupAssist Backup tab, see the Backup Tab user guide. 

Licensing 

Exchange Servers can be backed up using System Protection, File Protection and Files Archiving 

backups. Exchange Servers can be restored using the Integrated Restore Console. These features 

require a BackupAssist license, once the initial trial period has expired.  

Exchange Granular Restore Console requires the Exchange Granular Restore Add-on license. Please 

contact your local BackupAssist reseller or distributor for pricing information, or visit 

www.BackupAssist.com.  

For instructions on how to activate / deactivate license keys, visit our Licensing BackupAssist page. 

  

http://www.backupassist.com/downloads/v9/exchange-granular-restore-quickstart.pdf
http://www.backupassist.com/education/v9/backupassist/backup-tab-guide.html
http://www.backupassist.com/
http://www.backupassist.com/education/v9/backupassist/backupassist-licensing-guide.html
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2. Exchange Server Protection overview 

BackupAssist File Protection, File Archiving and System Protection backups use the Microsoft Volume 

Shadow Copy service (VSS) to back up your Exchange Server while it is running. BackupAssist can use 

these backups to perform a complete restore of your Microsoft Exchange Server or storage groups.  

Supported platforms 

To back up and restore your Exchange Server databases using BackupAssist you need: 

 Windows Server 2008 / 2008R2 or 2012 / 2012R2 / 2016 (from v9.5, does not include CSV support) 

 Windows Small Business Server (SBS) 2008 or 2011 

 Microsoft Exchange Server 2007, 2010, 2013 and 2016 (from v9.2) 

Requirements by platform 

The tables below are a reference for the combinations of Windows operating systems and Exchange 

Servers that can be used to provide Exchange Server Protection using BackupAssist. Windows Server 

VSS support for BackupAssist backup types: required for Exchange database backups. 

 
Windows 7, 8.1 & 

10 

Windows 

2008/R2 

Windows 

2012/R2 

Windows 2016 

(from v9.5) 

File Protection      

File Archiving      

System 

Protection  

    

Exchange VM support 

When backing up a Hyper-V guest with an Exchange Server, enter the authentication information for 

that guest into the Exchange VM Detection tab on the Selection screen when you create the job. 

With these credentials, BackupAssist can detect what guests have an Exchange Server, and list the EDB 

files available for each guest when you perform a restore using the Exchange Granular Restore console. 

 

Figure 1: Selection screen - for an Exchange Server on a Hyper-V guest 

 The Exchange VM Detection tab appears when the Hyper-V role is installed and running on the 

server. If you back up multiple guests, each one should have the same username and password. The 

Hyper-V process is automated but the restore requires both the Exchange Granular Restore Add-on and 

the Hyper-V Granular Restore Add-on licenses. 
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3. Exchange Granular Restore Add-on overview 

The Exchange Granular Restore (EGR) console allows you to restore mail items using Direct Exchange 

Injection. The backups used can be created by System Protection, File Protection or File Archiving. This 

means the backup you use to protect your Exchange Server can also be used to restore mail items.  

Supported platforms 

Exchange Granular Restore supports the following versions of Microsoft Exchange: 

 Exchange Server 2016 (from v9.2) 

 Exchange Server 2013 

 Exchange Server 2010 

 Exchange Server 2007 

Requirements 

 BackupAssist 7.2 or later must be installed on the Exchange Server.  

 RAM: 256-1024 MB, depends on mail store size and OS version 

 May require free space on disk 1.5x the size of mail data being processed. 

Backup type support  

Exchange Granular Restore supports the following backup types: 

 System Protection 

 File Protection 

 File Archiving 

Restore options 

The Exchange Granular Restore Add-on can restore the following items: 

 Mailboxes, mail folders and emails (cannot be encrypted) 

 Folders 

 File attachments 

 Contacts, Notes, Tasks and appointments  

Journals, emails attached in other emails and embedded email objects are currently not supported.  

Performance 

Exchange Granular Restore is tested for optimal performance up to the following dataset sizes. 

 Database size: 500 Gb / Mailbox size: 100 Gb  

 Number of messages in one mailbox - 100,000, in the database - 2,000,000. 

 Number of mailboxes in the database: 2,000   
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4. Creating an Exchange backup  

The following instructions describe how to create an Exchange Server backup job, using 

BackupAssist. These backups can be used to restore your Exchange Server as explained in 

section 5, and to restore individual mail items as explained in section 6. 

 

To enable the Exchange 2007 VSS writer, please refer to this blog article. 

To back up Exchange on a Hyper-V guest for EGR, review the Exchange VM Detection section 

Launch BackupAssist and follow the steps outlined below: 

1. Select the Backup tab, and click Create a new backup Job 

2. Select System Protection, File Protection or File Archiving.  

The following instructions use System Protection to explain the Exchange VSS back up process.  

 

Figure 2: New backup job – backup type selection screen 

Back up instructions specific to each backup type, can be found in these user guides: 

 BackupAssist System Protection System Protection user guide 

 BackupAssist File Protection File Protection user guide 

 BackupAssist File Archiving  File Archiving user guide  

http://www.backupassist.com/blog/support/how-to-enable-the-exchange-vss-writer/
http://www.backupassist.com/education/v9/backupassist/system-protection-guide.html
http://www.backupassist.com/education/v9/backupassist/file-protection-guide.html
http://www.backupassist.com/education/v9/backupassist/file-archiving-guide.html
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3. Selections 

The selections screen is used to select the data and applications that you would like to back up. 

Any local Exchange Servers detected will be displayed here as application containers. 

An Exchange VM Detection tab will be available if you are backing up an Exchange VM guest.  

You can select an entire VSS application or choose individual components. To back up your 

Exchange Server, select the Microsoft Exchange container. 

If your local Exchange Server is not listed in the Selections screen, try restarting Exchange and the 

VSS service and click the Refresh button in BackupAssist. 

 
Figure 3: New backup job – Exchange Server VSS selection 

 For System Protection backups, VSS applications will be backed up as part of a Backup up the 

Entire System selection. In the example above, Back up selected items only, was chosen and the 

Exchange Server application container was selected.  

 To learn how to create a bare-metal backup using System Protection (for use in a recovery), see 

the System Protection user guide. 

 For File Protection, File Archiving and System Protection backups, the top level Microsoft 

Exchange and Exchange Server application containers should be selected. 

4. Destination media 

The destination screen is used to select the type of media that you want to back your data up to. 

This step’s name will change to the media type selected, when you click next. 

Select a device for your backup destination, and click Next.  

http://www.backupassist.com/education/v9/backupassist/system-protection-guide.html
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5. Schedule 

This screen is used to select when and how you would like the backup job to run, and how long 

you would like the backup to be retained for.  

A selection of pre-configured schedules, called schemes, will be displayed.  

 The schemes available will depend on the type of destination media selected in step 4.  

 Clicking on a scheme will display information about the schedule used. 

Select an appropriate scheme, and click Next. 

For detailed information on scheduling options and customizations, see the Backup tab user guide. 

6. Set up destination 

This screen is used to configure the location of the media selected in step 4.  

The options presented will change with the type of media selected. 

If you are using a Local media & Local network destination, a Check destination button will be 

available to check your backup destination for possible problems. After the checks have been 

completed, the results can be viewed by selecting the Report link. If you are using Removable media 

destinations, these checks are performed when you select Prepare on the Prepare Media step. 

 

Figure 4: New backup job - Set up destination 

Configure your backup destination, and click Next. 

Mail Server: If you have not configured an SMTP mail server for BackupAssist, you will be 

prompted to provide those details after the backup destination step has been completed.  

http://www.backupassist.com/education/v9/backupassist/backup-tab-guide.html
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7. Notifications 

Once a backup job has completed, BackupAssist can send an email to inform selected recipients of 

the result. This email notification can be enabled during the creation of a backup job, if the mail 

server has been configured.  

To send email notifications, you will need to configure an SMTP mail server for BackupAssist. See 

the BackupAssist settings section to learn more or the Backup tab user guide for instructions.  

To enable email notifications: 

a. Select, Add an email report notification. 

b. Enter recipients into the Send reports to this email address field. 

c. Enter recipients into the Also send reports to this email address field. You can then select the 

condition under which the email should be sent, using the drop-down box. 

After the backup job has been created, you can modify the notifications by adding and removing 

recipients, setting additional notification conditions and including print and file notification types.  

To learn more about notification options, see the Backup tab user guide.  

8. Prepare media: 

If you selected a portable media device as your backup destination, you will be given the option to 

prepare and label the media. The label allows BackupAssist to recognize the media and ensure that 

the correct media is being used on the correct day.  

For example, if you put an RDX drive in on Tuesday but it was labelled Wednesday, BackupAssist 

will warn you that the incorrect media has been detected. 

 

Figure 5: New backup job – Prepare media  

http://www.backupassist.com/education/v9/backupassist/backup-tab-guide.html
http://www.backupassist.com/education/v9/backupassist/backup-tab-guide.html
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To enable media detection: 

a. Select, Let BackupAssist keep track of your media. 

b. Select what you would like BackupAssist to do, if the wrong media is inserted. 

c. Select what you would like BackupAssist to do, if new or unrecognized media is inserted. 

BackupAssist will display all removable media that are currently attached, along with a text field 

and drive designation drop-down box, which can be used to provide a label for the media. 

To prepare your media: 

d. Enter the name and drive designation to be used for each media device listed. 

e. Select Prepare for each media device listed. 

Selecting Prepare will generate a Destination Check Report. The report will advise if any problems 

were detected with the media.  

9. Name your backup: Provide a name for your backup job, and click Finish.  

Your Exchange Server (VSS) backup job has now been created. 

Important: Once the backup has been created, it should be checked. You can check the backup by 

performing a manual test restore, or using the Backup Verification feature.  

Please note that a manual restore is the only way to fully test a backup, and regular manual restores 

should be part of your backup solution.  

http://www.backupassist.com/education/resources/backup-verification.html


 

Exchange Protection 
© Cortex I.T. 2001-2017   Version Oct 26 2016 

10 

 

5. Exchange Server restore 

BackupAssist’s Restore tab displays two options for Exchange: Exchange Server restore and 

Exchange Granular restore. This section explains how to perform an Exchange Server 

restore using a System Protection, File Protection or File Archiving backup.  

Exchange Server restore is used to restore a full Exchange Server or individual EDB storage groups. 

Performing these restores may require preparations and considerations that go behind the scope of the 

restoration of the data. The Microsoft’s Exchange Server restore resources should be consulted before 

planning and performing an Exchange Server restore. 

To restore an Exchange Server or EDB database, follow the steps below: 

1. Select the Restore tab 

The Restore tab has a Home page and a Tools page. The Home page is the default page and the 

recommended starting point for performing a restore. The Tools page should only be used by 

experienced administrators or users being assisted by technical support.  

2. Select Exchange Server 

This will display the Exchange Server backups created by this installation of BackupAssist. It can also 

show backups from other machines added using the Discover Backups button.  

Expand a volume to display all of the backups available for that volume. The tabs above each 

volume’s list of backups can be used to help locate the required backup. 

 The Last 7 days and Last 30 days tabs display the backups within those ranges. 

 The Custom tab allows you to select a specific date range and display backups for that period. 

 

Figure 6: Restore tab – backup selection 
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Discover Backups allows you to browse for backup catalogs created by deleted jobs and other 

servers. Selecting those backups will add them to the list of available backups. 

3. Select the backup that you want to restore from 

Clicking on a backup’s name will open the Integrated Restore Console (IRC). The Integrated Restore 

Console is used to select the data to be restored, where to restore it to and the restore conditions. 

4. Select the Exchange Server or database that you want to restore 

Use the left pane to select the Exchange Server or the databases that you want to restore. The right 

pane will display the contents of the folder selected in the left pane. 

 

Figure 7: Integrated Restore Console 

5. Select Where to restore the data to 

Follow these steps to select the restore destination and the restore options: 

a) Under Where to restore select To original location or To Specific location. 

b) Use the Browse button to locate and select the restore destination. 

c) Use the drop down box to set the overwrite rules. The overwrite rules will apply if the files 

being restored encounter files with the same name in the restore destination.  

You can select: 

Overwrite existing files - The restored files will overwrite files in the restore destination. 

Do not overwrite existing files – The restored files will not overwrite files in the restore 

destination. This means the files will not be restored. 

Only overwrite older files - If a source file has changed since the backup was made it will not 

be overwritten. 
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d) Review the Restore NTFS security attributes option 

If you select this option, the NTFS security attributes the file had when it was backed up will be 

retained when the file is restored. The NTFS security attributes can be viewed in the Security tab 

on the file’s Properties. 

e) Review the Take ownership of restored files option 

Selecting the Take ownership of restored files tick box will give the current user ownership of 

the restored files. The user is shown to the right of the text box description. 

6.  Select Restore 

When you select the Restore button, the restore process will begin. The Integrated Restore Console 

will display information about the restore job and provide status updates as the job runs. 

 

Figure 8: Integrated Restore console – restore monitor 

Selecting List all processed files and folders … will open notepad and display a list of the files 

restored, including their full path. 

Encrypted backups 

If your backup is encrypted, you’ll be prompted for the encryption password when the restore job 

tries to access the backup. It is important that you keep a copy of your password in a safe place, as 

we cannot assist you with opening password encrypted files if your password is lost or forgotten. 

If you encrypted the backup using BitLocker, you can use the password or encryption key to unlock 

the drive by connecting the flash drive. BackupAssist will use the key to unlock the drive that you 

are restoring from. You will not be prompted to do anything other than the normal restore steps. 

7. Select Done 

Once the restore has finished, selecting Done will return you to the main UI. 

Your Exchange Server restore has now been completed. 

 

 



 

Exchange Protection 
© Cortex I.T. 2001-2017   Version Oct 26 2016 

13 

 

6. Exchange Granular Restore 

BackupAssist’s Restore tab displays two options for Exchange: Exchange Server restore and 

Exchange Granular Restore. This section explains how to perform an Exchange Granular 

Restore using a System Protection, File Protection or File Archiving backup.  

Exchange Granular Restore will restore individual mail items from an Exchange Server database or 

PST file. This feature requires an Exchange Granular add-on license.  

When you restore individual emails or a mailbox, the word RESTORED will appear in the Subject line of 

every email. This is enabled by default and can be turned off using the EGR Options menu, by selecting 

Options > Add RESTORED to exported item > No. 

The restore Home page can display backups of Exchange databases inside Hyper-V guests. Mail items 

inside the guests can be restored using Exchange Granular Restore. The Hyper-V restore process is 

automated but the restore requires both an Exchange Granular Add-on and a Hyper-V Advanced add-

on licenses. Refer to the Exchange VM Detection section to learn more. 

To perform an Exchange Granular Restore, follow the steps below: 

Step 1 - Locate the Exchange backup 

1. Select the Restore tab 

The Restore tab has a Home page and a Tools page. The Home page is the default page and the 

recommended starting point for performing a restore. The Tools page should only be used by 

experienced administrators or users being assisted by technical support.  

 

Figure 9: Restore tab 
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2. Select Exchange Granular Restore 

This will display the Exchange Server backups created by this installation of BackupAssist. It can also 

show backups from other machines added using the Discover Backups button.  

Clicking the Exchange Server heading will display all backups available for that Exchange Server. 

The tabs can be used to help locate the required backup.  

 The Last 7 days and Last 30 days tabs can be used to display the backups within those ranges. 

 The Custom tab allows you to select a specific date range and display backups for that period. 

 

Figure 10: Restore tab – backup selection 

Discover Backups allows you to browse for backup catalogs created by deleted jobs and other 

servers. Selecting those backups will add them to the list of available backups. 

3. Select the backup that you want to restore from 

Clicking on a backup’s name will display a drop down list of Exchange databases (EDB files) that 

you can restore from.  

4. Select the Exchange EDB database that you want to restore 

The will open the Exchange Granular Restore console, which will open the Exchange database and 

allow you to view the mail items inside it. 

If you opened Exchange Granular Restore from the Tools menu, you can browse to, and open, an 

EDB, PST or OST file. You can then search the PST or OST file, and restore the selected mail items. 
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Step 2 - Locate the mail items 

The Exchange Granular Restore (EGR) console has a Browse mail tree and a Search field to help locate, 

preview and select the mail items that you want to restore.  

If you open EGR from the Restore > Tools menu, you can open a database using the Open Exchange DB button. 

Console options 

Both the Browse and Search functions can use the following options. 

 Display filter: Press CTL+F and a Filter field will appear under the list of currently displayed mail 

items. Select the Subject, From, To, Attachments, Created or All filter, and enter the text to filter by. 

 Restore Deleted items: Display hidden deleted items, is available in the Options menu, and 

selecting it will give access to previously deleted mail items. This is not mail from the delete items 

folder but mail items that are no longer present. The database will reload when a selection is made 

and the deleted items will and have a flag to indicate that they are a deleted item. 

 Deleted items from Exchange Server 2007 are stored in their original folders. 

 Deleted items from Exchange 2010 and later are stored in the folder Deletions. These items 

cannot be restored to live Exchange Server database. It is recommended that these items are 

exported to a PST file and then imported into the live Exchange Server. 

 Display time: Select Display time, from the Options menu and select Local or GMT. This applies to 

the date in the properties tab of a mail item. The database will reload when the format is changed.  

Using Browse 

The Browse mail tree is displayed in the console’s left pane. Browsing for the items you want to restore 

is ideal when you know their location.  

 
Figure 11: The Exchange Granular Restore console 

 Selecting a folder will display the individual mail items inside it, on the pane to the right.  

 Selecting a mail item will preview its contents in the pane below it.  



 

Exchange Protection 
© Cortex I.T. 2001-2017   Version Oct 26 2016 

16 

 

Using Search 

The Search field is ideal when the location of a mail item or the number of items to restore is unknown. 

When a keyword search is performed, a new tab with a browse tree will open containing only the 

mailboxes, folders and mail items that match your search criteria.  

The search word must be a whole word. 

To perform a simple Search, enter the search word into the field, click the search icon and the Search 

tab will open in the console. This Search tab will contain all items in the database that contains the 

word you entered. 

To perform an advanced Search, select the arrow by the Search field to display the advanced search 

options. The Search in field will default to the entire database. To search inside specific mailboxes or 

folders, select the Search in field and use the dialogue window to select the required containers. 

The following search options are available: 

 Has words, searches for mail items that have words or phrases entered into the field.  

 Doesn't have, searches for items that do not have words or phrases entered into the field.  

 Has attachments, will search for items with attachments.  

 From, will search for keywords in the From: field.  

 To, will search for keywords in the To: field.  

 Subject, will search for keywords in the Subject: field.  

 Date range, can be used to set a specific date range. A beginning and end dates must be set.  

 

Figure 12: Exchange Granular Restore console - Search tab 

If a search does not match any items, review your search parameters and run another search.  

Once you have located the mail items that you want to restore, select them using the tick box. Once 

you have selected an item to restore, the restore type icons in the menu will become active. 
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Indexing Modes  

Database indexing can be disabled or cancelled via the Options menu. If indexing is disabled, a 

database search will not be possible. Two indexing modes are supported: Light and Full.  

 Light indexing (default): Limits the searchable information to the following fields: From, To, Subject, 

Date range. A To field with a long recipients list and message bodies will not be indexed.  

 Full indexing: This mode will take longer to index as it allows a search across the entire database. 

Step 3 - Perform the restore 

Once you have located the required mail items, there are three ways they can be restored using 

Exchange Granular Restore: Restore to original location, Restore to alternate location and Export to PST.  

Option 1: Restore to original location 

This option will restore the selected mail items back into their respective mailboxes on the 

original Exchange Server.  

To perform the restore, follow the steps below: 

a) Select the Restore to original location button. 

A Restore to original location window will open. The domain name of the server running Exchange 

will be automatically detected if you are on the same domain.  

b) If no Exchange Server was detected, manually fill in the Server name field and click Reconnect. 

It is possible to restore data to someone else’s mailbox using Exchange Impersonation. To do this, 

the current user credentials must have Exchange Impersonation access to the destination mailbox. 

 

c) Select Restore, to begin the restore process. 

A progress window will be displayed during the restore. The window shows the number of folders, 

messages and errors. You can enable and disable the progress window in the Options menu. 

 The restore can be cancelled by clicking the Cancel restore button. 

 The progress window can be reopened by clicking Progress bar on the status panel. 

 Selected items will be copied into their original locations on the live Exchange Server. If 

selected items cannot be matched to a destination mailbox, they will not be restored. 

 The destination Exchange Server is detected automatically using the current Active Directory 

domain. If necessary, you can change the server name and attempt a reconnect. 

http://www.backupassist.com/education/resources/egr_impersonation.html
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Option 2: Restore to alternate location 

This option will restore the emails and mail items from the offline backup to a live Exchange 

database that is different to the one they were backed up from. 

To perform the restore, follow the steps below: 

a) Select the Connect to Exchange Mailbox button. 

The Connect to Exchange Mailbox button will open the connection dialog box, which is used to 

provide the Exchange Server name and the authentication details (User logon) for a specific 

mailbox on that server. This authentication process can be repeated for additional mailboxes.  

The Restore to alternate location button will become active when a connection has been made. 

 

Figure 13: Restore to alternate location – connection authentication 

Enter the following details into the connection dialog box: 

 Server name - Domain name Exchange Server or IP address 

 Mailbox user name - This will identify, authenticate and open the applicable mailbox. 

 Password- The password for the applicable mailbox. 

If Use current Windows credentials is selected, the existing user’s Windows password will be used. 

If Exchange Impersonation is selected, enter the SMTP address of the mailbox that you want to 

connect to. Exchange impersonation must also be configured on the Exchange Server.  

Once the connection has been made, the mailbox you have authenticated to will appear as a 

mailbox tree in a new pane called Connected Mailboxes. You can open a preview pane for the 

destination mailbox tree by selecting the Show item list and preview icon (CTL+R), to the right of 

the Connected Mailboxes pane.  

b) Restore mail items to an alternate location 

There are two ways to restore mail items to the alternate location: drag and drop and the Restore to 

alternate location button.  
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Drag and drop 

Drag and drop mail items from the backup, into the live Exchange mailbox that you connected to.  

 The hierarchy of the data being dragged will be recreated inside the destination folder.  

 You can create a new folder in the live mailbox by right clicking the mailbox or a folder. Note, 

you cannot delete or rename a folder once it has been created. 

 
Figure 14: Mail item selection 

Restore to alternate location button  

Click the check-box next to items that you want to restore and select the Restore to alternate 

location button. A dialog box will open and allow you to select a destination folder on one of the 

connected mailboxes. Make your destination selection and select OK to begin the restore 

 The data hierarchy will be restored automatically.  

 The root of hierarchy is the closest common parent item. 

Source mail items and destination folder compatibility 

Not all types of mail items can be restore to all types of destinations folders. The following table 

shows the compatibility matrix of source mail item types and destination directories. 

Item type *Mail folder Journals Notes Contacts Calendar Tasks 

Message Y Y Y Y Y Y 

Journal Y Y Y Y Y Y 

Sticky Note Y Y Y Y Y Y 

Contact N N N Y N N 

Calendar N N N N Y N 

Task N N N N N Y 

* The Mail folder includes Deleted Items, Drafts, Inbox, Junk, Outbox and Sent.  

If some or all of the selected items cannot be restored (using drag and drop or clicking the Restore 

to alternate location button) to the destination folder, then an error message will be displayed. 
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Option 3: Export to PST 

Export to PST will save your selected data in a PST file, which can be opened by outlook to 

access the mail items. 

To perform the export, follow the steps below: 

a) Confirm the Personal Storage Table (PST) format  

You can choose Unicode or ANSI encoding for the PST output file using the Options menu.  

The Exchange Granular Restore console exports each mailbox into a separate .pst file named: 

“Restore NNN <Mailbox Name>[ VVV]. pst”, where NNN is the current recovery session identifier 

and VVV is the volume number, in case the PST file has to be written in more than one volume.  

With large exports, there can be more than one PST file. Additional files are created automatically 

when the file size limit is reached. The size limit depends on the output file encoding.  

 For ANSI PST files, the size limit is 1 GB. 

 For Unicode PST files, the size limit is 10 GB.  

 A maximum of 15,000 messages can be restored into the PST file.  

 When this limit is reached, an additional PST file is created.  

b) Select the , Export to PST button 

This button will become active once the mail items have been selected. 

c) Select the destination. 

You will be asked to select a folder or create a new folder. After selecting the new or existing folder, 

the export will begin.  

You will be shown a progress window during the export. The window shows the number of saved 

mailboxes, folders and messages. The export can be cancelled by clicking the Stop Export button. If 

you close the progress window, it can be opened again by clicking the status panel‘s progress bar. 

 

The items selected (even if you only selected one item) will be exported as a PST file. 
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d) Open the exported mail items in Outlook. 

1. Click File > Open and choose Open Outlook Data File.  

2. Browse to the PST file that was exported, then select it and click OK.  

3. The PST file will appear in Outlook as a container. 

 

Figure 15: Opening an exported PST file in outlook 

e) Restore the exported items to the Exchange Server.  

Items extracted from an offline Exchange mail store can be restored to a live server. Make sure you 

have Microsoft Outlook and access to the mailbox that you want to restore the mail items into.  

1. Open the PST file that contains the exported mail items. 

2. Open the mailbox that you need to import the data into.  

3. Drag-and-drop the item them back into their original folders. They will be automatically 

synchronized with the live Exchange Server database.  

 

Figure 16: Restoring a PST file to an Exchange Server. 


